Photoshop’s Tools Panel

As explained in Chapter 1, the Tools panel is home to many of Photoshop’s most important implements. This appendix gives you a quick rundown of everything in this virtual toolbox and points you to where you can learn more about each tool.

Note: In this appendix, each tool’s keyboard shortcut is listed in parentheses after its name. As you learned on page 23 in Chapter 1, all the tools in a given toolset share the same keyboard shortcut.

Move, Selection, and Crop Tools

These are the tools you use to tell Photoshop what part of an image you want to edit or trim. Once you’ve created a selection, you can move those pixels to another spot, change their color, apply a filter to them, and so on. The selection tools are covered in detail in Chapter 4.

- **The Move tool (V)** is the black arrow at the top of the Tools panel (see Figure D-1, left). You can use it to grab and move a selection (page 177), whole layers (page 96), and guides (page 70).

- **The Marquee tools (M)** are nestled just below the Move tool; they include the Rectangular, Elliptical, Single Row, and Single Column Marquees. You’ll use the Rectangular Marquee the most as it’s great for selecting square and rectangular areas. To use any of these tools, just click and drag diagonally and Photoshop marks your selection with an army of marching ants (page 136).
Move, Selection, and Crop Tools

Figure D-1:
Left: The Move tool perches at the very top of the Tools panel, followed by the Marquee toolset. You can find a toolset’s keyboard shortcut by opening the toolset’s menu or hovering your cursor over the tool for a few seconds until a yellow tooltip appears.

Right: Photoshop’s Lasso toolset includes the Lasso, Polygonal Lasso, and Magnetic Lasso tools.

Tip: To cycle through the different tools in a toolset, add the Shift key to that group’s keyboard shortcut. For example, to switch between the Rectangular and Elliptical Marquee tools, press Shift-M.

- The Lasso tools (L) let you draw selections by hand (page 162). They’re great for selecting irregular-shaped areas or objects that you can’t get with the Marquee tools. To use the basic Lasso tool, click where you want the selection to start and then drag to draw an outline around the rest of the object. When you release your mouse button, Photoshop automatically adds a straight line that connects the start and end points of the line you drew. The Polygonal Lasso tool is handy for selecting objects with a lot of angles because it draws only straight lines; you simply click when you want to change directions. The Magnetic Lasso tries to guess what you want to select as you hover your cursor over an object.

- The Quick Selection tool (W) lives just below the Lasso tools (see Figure D-2, left). Click or click and drag with this tool across the area you want to select, and Photoshop tries to figure out the shape of the object you’re after by selecting areas that are similar in color to the ones you “brush” across (page 149). It’s great for grabbing selections based on color, and the painting metaphor makes it simple to use.

Figure D-2:
Left: The Quick Selection and Magic Wand tools make selections based on color.

Right: Use the Crop tool to remove unwanted bits around the edges of your images and the Slice tool to chop up images destined for life on the Web.

- The Magic Wand tool (W) also creates selections based on color (its icon looks like a wizard’s wand). Click once on the color you want to select and Photoshop grabs all the contiguous pixels that are similarly colored (page 151). You can
then Shift-click to add an area to the selection or Option-click (Alt-click on a PC) to subtract an area from the selection.

- **The Crop tool** (C) lets you trim distracting elements from the edges of your image, as well as change the size of your image. Simply use it to draw a box around the part of the image you want to keep and then press Return (Enter on a PC) to delete everything outside the box. Page 222 has the details.

- **The Slice tools** (C) let you carve your images into pieces that’ll end up on a web page (page 731). The Slice tool looks and acts like an X-Acto knife—it records how you’d like your image chopped up once it’s saved for the Web (it doesn’t make any changes to the way your image looks). The Slice Select tool lets you choose slices and move them around or assign URLs to them. Chapter 17 has the scoop on slicing and dicing your images for life on the Web.

- **The Eyedropper tool** (I) lets you choose a color you want to use as your foreground color chip (page 14). It looks—not surprisingly—like an eyedropper (see Figure D-3, top), and it’s extremely useful for picking colors for painting (Chapter 12), creating new backgrounds (page 47), and color-correcting images (Chapter 9). In Photoshop CS5, this tool includes a Sample Ring option—a .25”-wide circular band around the cursor that displays the previously chosen color on the bottom half and the new color on the top; it makes snatching just the right color a snap.

- **The Color Sampler tool** (I) marks the spot you click with a number and logs the color value of those pixels in the Info panel. Use this tool to color-correct by the numbers as explained on page 401.

- **The Ruler tool** (I) measures the distance and angle between two points in your image and displays that info in the Options bar and Info panel (its button looks like a little ruler). All you need to do is drag from one point to another and then release your mouse button—Photoshop calculates the distance between the points and the angle of the line. In CS5 you can use this tool to straighten crooked images. See page 71 for the lowdown.

- **The Note tool** (I) looks like a small Post-It note, and lets you add annotations to your documents. To add a note, simply select this tool, click where you want the note to appear, and Photoshop opens the Notes panel so you can type your comments (see Figure D-3, bottom).

- **The Count tool** (I) is available only in Photoshop CS5 Extended (page 1). This tool was added to help researchers count objects (such as blood cells) in digital images. If you use this tool in manual mode, Photoshop tracks how many times you click in an image and displays a running total in the Measurement Log panel (Window ➔ Measurements Log). To make Photoshop count items for you, use the Magic Wand tool to select the objects you want to count. Then choose Analysis ➔ Select Data Points ➔ Custom, make sure the Count option is turned on, and then click OK. Finally, choose Analysis ➔ Record Measurements to open the Measurements Log panel and display your tallied results.
Retouching and Painting Tools

You can use the retouching tools to repair and enhance your images (for the scoop on retouching people, flip back to Chapter 10). In the Tools panel, the retouching tools are grouped with the painting tools because most of them are brush-based (meaning they use a brush cursor). The Brush tool is covered extensively in Chapter 12 (where you'll also find some bonus info on color theory).

Since these tools are brush-based, you aren't limited to the standard round brush cursor with different hardness or opacity levels. You can select any of the custom,
preset, or sampled brushes covered in Chapter 12, which gives you a wide range of options to experiment with when applying effects or retouching your images. To change the brushstroke, just hop up to the Brush menu in the Options bar.

- **The Spot Healing Brush (J)** looks like a Band-Aid with a circle underneath it (see Figure D-4, left), which is appropriate because it’s designed to remove round blemishes. If you make your cursor slightly larger than the blemish you want to zap and then click the offending blemish, Photoshop blends the area you clicked with the surrounding pixels. In Photoshop CS5, this tool scored a new option called Content-Aware Fill which helps retouched areas blend more accurately with surrounding pixels. You can see it in action on page 425.

- **The Healing Brush (J)** lets you repair imperfections that aren’t round. This tool also looks like a Band-Aid and you can use it to fix wrinkles, dark circles, and so on. You tell Photoshop what you want the problem area to look like by Option-clicking (Alt-clicking on a PC) a good area and then simply paint the imperfection away as explained on page 427.

- **The Patch tool (J)** works like the Healing Brush except you draw a selection around the problem area in your image and then drag your selection to a good area—Photoshop blends the two areas together with remarkably good results. This tool is great for fixing bags beneath eyes or getting rid of small objects you don’t want in your image (see page 431).

- **The Red Eye tool (J)** does just what its name implies: You use it to draw a box around the offending eye (the whole eye, not just the pupil), and Photoshop identifies the problem red area and replaces it with dark-gray pixels. See page 452 for the scoop.

- **The Brush tool (B)** lets you paint with a variety of brushes; its icon looks like—you guessed it—a little brush. Photoshop includes a ton of built-in brushes, but you can also edit them and create your own. This tool is covered in great detail in Chapter 12. Photoshop CS5 includes a slew of new brush tips that behave like their real-world counterparts—their bristles even splay when you paint!

- **The Pencil tool (B)** is really a hard-edged brush that gives you few options other than changing its size. It’s not terribly useful because, if you draw with it, you’ll produce extremely jagged lines. This tool does have one cool feature,
though: Auto Erase, which lets you undo brushstrokes by painting back over them (see page 508). If nothing else, it’s a cool trick to show friends. Otherwise, stick with the Brush tool for your painting needs.

- **The Color Replacement tool (B)** lets you substitute one color for another by painting over the area. It’s great for removing super-stubborn red eye. Page 454 has the details.

- **The Mixer Brush (B)** is new in Photoshop CS5. You can mix paint with it (either new paint or color from an existing photo), set it to clean itself after each stroke, and more. It’s just the ticket for creating realistic painting effects, as shown on page 502.

- **The Clone Stamp tool (S)**, whose icon looks like an old-fashioned rubber stamp (see Figure D-5, left), works a little differently than the healing and patch tools. Instead of blending pixels together, it copies part of an image to another spot. Page 312 shows you how to use it to clone an object from one image to another, and page 434 explains how it can help you zap shines and shadows in portraits.

- **The Pattern Stamp tool (S)** lets you paint patterns on your image, and its icon looks like a rubber stamp. Even though it’s called a stamp, it acts more like a brush. Pick a pattern in the Options bar and then paint away. If you don’t like the pattern presets that come with Photoshop, you can load the other pattern libraries or create ones of your own. The steps for making your own pattern are the same as for creating your own brush (page 531) except that you choose Edit→Define Pattern instead.

- **The History Brush (Y)** is like a time machine because it lets you paint over parts of your image to reveal a previous version of your work. See page 29 to learn more.

- **The Art History Brush (Y)** lets you add bizarre effects to your image by painting to expose a previous state, but with an extra twist: Instead of simply revealing what was there before, it applies effects so the image looks rather impressionistic. It’s covered in the box on page 536.

---

**Figure D-5:**
Left: Photoshop’s Clone Stamp tool can copy part of your image to another spot in the same image, or to another image entirely. Use the Pattern Stamp tool to paint with Photoshop’s built-in patterns or one that you’ve created.

Right: Some brushes add to your images, others take away. The History and Art History brushes wipe away your edits to reveal how your image looked before you changed it.
The Eraser tool (E) lets you paint to erase parts of your image. Its icon looks like the pink erasers you used in elementary school (see Figure D-6, left), and it works nearly the same way: Grab it from the Tools panel and select a mode from the Options bar (Brush, Pencil, or Block mode), and then drag across your image to erase pixels in that area. Erasing on a layer removes pixels from just that layer, while erasing on the Background layer replaces those pixels with your background color (see the box on page 85 for more on the Background layer).

Figure D-6:
Left: You can easily zap unwanted pixels with the Eraser tool.
Right: The Gradient and Paint Bucket tools let you fill a selection or entire layer with color.

The Magic and Background Eraser tools (E) do their best to remove backgrounds from your images while leaving the foregrounds intact. They work by examining the colors of the pixels you brush across (or click) and erasing nearby pixels with similar color values. You can see them both in action on page 157.

Tip: The Magic and Background Eraser tools are great for removing small areas in your image, but if you need to hack away big chunks, use the Quick Selection tool instead.

The Gradient tool (G) lets you fade one color into another to create backgrounds or add color overlays to your images. It looks like a rectangle filled with black that fades to white. You can use it to fill areas you’ve selected, text (page 621), or whole layers. When used with a layer mask, it’s great for gradually fading one image into another (page 287), applying a colored tint (page 363) or fading a colored image to black and white (page 334).

The Paint Bucket tool (G) fills areas with solid color. It’s the tool equivalent of the Edit ➔ Fill command (page 181). It uses whatever color your foreground color chip is set to (page 24), so be sure to change that color before reaching for this tool.

The Blur tool lets you paint to make parts of your image look like they’re out of focus. Its icon looks like a raindrop (see Figure D-7, left), perhaps because real water drops blur paint. Since it uses a brush cursor, you can use the Options bar to set its size and hardness. (A harder brush leaves more defined edges in its wake; a softer brush leaves more of a blur.)
Retouching and Painting Tools

Figure D-7:
Left: You can use the Blur and Sharpen tools to edit only the areas that need fixing. Be sure to adjust their Strength settings in the Options bar, as they’re extremely destructive.

Right: The Dodge and Burn tools let you lighten and darken your image (respectively) by hand using a brush cursor. Even though they were revamped back in Photoshop CS4, they’re still fairly destructive and, if you’re not careful, can inflict serious harm on your image. To learn how to use the Brush tool to create the same effects, flip back to page 447.

- **The Sharpen tool**, whose icon looks like a tall triangle, enhances the contrast around an object’s edges to make it look clearer. It’s helpful when you need to sharpen really small areas by hand. By lowering its Strength in the Options bar, you can keep from totally destroying your image (see the box on page 474). That said, Chapter 11 is chock-full of safer sharpening techniques.

- **The Smudge tool** works like a digital finger you can drag across an image to smear it as if you were finger painting. You can adjust its cursor size and mode in the Options bar. Its factory setting samples (copies) colors from the current layer only; if you want it to sample from all layers, turn on the Sample All Layers checkbox. Turning on the Finger Painting checkbox makes this tool paint with the current foreground color instead of the colors in your image.

  **Note:** The Blur, Sharpen, and Smudge tools don’t have keyboard shortcuts. Maybe because you’ll rarely use ‘em!

- **The Dodge tool (O)** lets you lighten parts of your image using a brush cursor, much like old-school photographers used the dodging technique to control exposure in their darkrooms (see page 448). The key to success with this tool is to lower its Exposure setting in the Options bar significantly.

- **The Burn tool (O)** works just like the Dodge tool except it *darkens* parts of your image. (Its icon looks like a hand making an “O” shape.) Here again, be sure to significantly lower the Options bar’s Exposure setting because its factory setting is way too strong (see page 448).

- **The Sponge tool (O)** works with the Dodge and Burn tools, but it doesn’t change an image’s exposure. Instead, it increases or decreases its color saturation, as explained on page 455. It can be handy when you need to drain a very small area of color (such as a stubborn red eye).
Drawing and Type Tools

These tools let you draw perfectly crisp-edged shapes that you can enlarge without losing quality because they’re made of vectors (see page 52), just like Photoshop text. See Chapter 13 to learn about the drawing tools and Chapter 14 for more on working with text.

- **The Pen tool (P)**, whose icon looks like an old-fashioned fountain pen nib (see Figure D-8, left), lets you draw a line by clicking in one spot and then clicking elsewhere to add anchor points, in between which Photoshop places a line called a *path*. You can use it to create amazing illustrations and complex selections. It’s discussed at great length in Chapter 13 starting on page 541.

- **The Freeform Pen tool (P)** lets you draw with the Pen tool freehand. It limits you to starting and ending anchor points, but it gives you the freedom to draw any line shape without stopping to add extra points along the way. (You can always go back later and add more points if you need to refine your shape.) The box on page 552 has more info.

- **The Add Anchor Point, Delete Anchor Point, and Convert Point tools** let you edit shapes you’ve drawn with the Pen tool. They’re discussed in Chapter 13 (page 557).

- **The Horizontal and Vertical Type tools (T)** let you add text to your image. As you might suspect, the Horizontal Type tool creates text that runs left to right and the Vertical Type tool creates text that runs top to bottom. You use the Options bar to choose a typeface, point size, and so on. Chapter 14 teaches you all about these tools, as well as a fair amount about typography.

- **The Horizontal and Vertical Type Mask tools (T)** let you create the *outline* of text that you can fill, stroke (outline), and use like any other selection. They’re great for applying special effects in the shape of text. See page 589 for some cool ideas on how to use these unique tools.

- **The Path Selection tool (A)** lets you choose paths you’ve created with the Pen tool, shapes you’ve converted to paths, and even text (see page 595). Its icon looks like a black arrow (see Figure D-9, left) and it’s described beginning on page 558.
• **The Direct Selection tool** (A) lets you grab anchor points or parts of paths instead of whole paths. Its icon looks like a white arrow with a black outline. Just like the Path Selection tool, it’s covered in Chapter 13 (page 558).

• **The Shape tools** (U) let you draw all kinds of shapes that are made out of vectors (page 52). Sure, you can draw rectangles and ellipses with the Marquee tools (page 139), but they aren’t nearly as versatile because shapes are made from points and paths instead of pixels. Each Shape tool’s icon looks like the shape it creates: Rectangle, Rounded Rectangle, Ellipse, Polygon, Line, and Custom Shape (which looks like a funky star). You can see these tools in action in Chapter 4, page 146, and on page 551 in Chapter 13.

### 3-D and View Tools

Photoshop CS5 Extended includes a set of tools for working with three-dimensional objects. They let you edit 3-D objects made with programs like Adobe Acrobat 3D Version 8, 3D Studio Max, Alias, Maya, and Google Earth (which create .u3d, .3ds, .obj, .kmz, and .dae files, respectively). You can also build your own 3-D shapes and rotate, animate, and add lighting effects to them. For more on Photoshop CS5’s 3-D capabilities, download the info posted on this book’s Missing CD page at [www.missingmanuals.com/cds](http://www.missingmanuals.com/cds) (it’s listed under Chapter 3).

The standard version of Photoshop CS5 doesn’t include these 3-D tools, but it does include the Hand, Rotate View, and Zoom tools, which are also covered in this section.

**Note:** In Photoshop CS4, the Hand, Rotate View, and Zoom tools lived in the Application bar as well as the Tools panel, but in CS5 they were relegated back to the bottom of the Tools panel from whence they came, freeing up more space for Live Workspaces (see page 18).

• **The 3D Object Rotate tool** (K) lets you click and drag 3-D objects to spin them end over end or from side to side (see Figure D-10, left). Dragging up or down spins the object end over end on its x-axis, and dragging them left or right spins it from side to side on its y-axis.
The 3D Object Roll tool (K) lets you spin a 3-D object around its center point (its z-axis—see the box on the next page). Just drag your object to send it on its circular journey.

The 3D Object Pan tool (K) moves 3-D objects up and down or side to side so you can get a better view of them.

The 3D Object Slide tool (K) lets you move 3-D objects closer to you or farther away from you. Drag up and down to change an object’s distance from you, or drag from side to side to move it left or right.

The 3D Object Scale tool (K) resizes your 3-D object. Drag up to make it bigger or down to make it smaller.

The 3D Rotate Camera tool (N) rotates your virtual camera on its x-axis.

The 3D Roll Camera tool (N) rolls your virtual camera on its z-axis, which makes it look like you’re spinning while the object remains stationary.

The 3D Pan Camera tool (N) creates a panning effect so you can view different parts of a stationary object by moving along the x- and y-axes.

The 3D Walk Camera tool (N) lets you move around an object as if you were walking around it. You can move forward and back along the y- and z-axes.

The 3D Zoom Camera tool (N) lets you drag to narrow the camera’s field of view and focus in on the object’s details. You can also zoom out for a big-picture view.

The Hand tool (H) is much more than a disembodied Mickey Mouse glove (see Figure D-11). It serves as a digital version of your own hand and lets you move images around on your screen. (It’s especially helpful when you’re zoomed in.) When you drag an image with the Hand tool, you’re not actually moving the image in your document, you’re just changing which part of the image you see. You can also use it to “toss” your images around if you have flick-panning turned on (see page 64). In addition to its keyboard shortcut, you can summon this tool anytime by pressing your space bar.
UP TO SPEED

**Understanding Photoshop’s Axes**

Since the images you work with in Photoshop are really two dimensional—even if you’re working with 3-D objects—Photoshop uses the terms *x-axis*, *y-axis* and *z-axis* to describe simulated 3-D movements in your document’s 2-D world. The *x-axis* represents horizontal (left and right) movement, the *y-axis* represents vertical (up and down) movement, and the *z-axis* represents changes in depth (forward and backward movement).

If this axis thing sounds familiar, it’s no surprise. These are the same principles you used to make graphs in math and science classes. If you ever wondered how those graphing skills would come in handy later in life, now you know.

---

**Figure D-11:**
The lower portion of the Tools panel includes the Hand, Rotate View, and Zoom tools, along with the foreground and background color chips and Quick Mask Mode button.

---

- **The Rotate View tool** (R) lets you rotate your view of an image to give you a more natural angle for painting or drawing—without rotating the image itself in the document. Its icon looks like a hand in front of a diamond shape; you can find it in the Hand toolset. Page 65 has the scoop on using this tool.

- **The Zoom tool** (Z), whose icon looks like a magnifying glass, lets you zoom in to take a closer look at what you’re editing. When you grab this tool and then click your image, you can keep zooming until you reach 3,200 percent magnification; Option-click (Alt+click on a PC) to zoom out. See page 60 for more info.

**Foreground and Background Color Chips**

As explained on page 24 in Chapter 1, you can only work with two colors at a time: a foreground color and a background color. You can tell which colors those are by looking at the bottom of the Tools panel (see Figure D-11), where you see two overlapping colored squares (the foreground color is the one on top). Flip back to page 24 to learn how to change these colors and what you’ll use ‘em for.

**Quick Mask Mode**

At the very bottom of the Tools panel is the Quick Mask Mode button, which looks like a circle within a rectangle. When you click this button (or press Q), Photoshop plops you into Quick Mask mode, where you can paint to create or edit a selection. It’s described in detail on page 176.